Entender a integracao de AP por meio do Plug
and Play do Catalyst Center

Contents

Introdugéo
Descri¢do
Requisitos
Pré-requisitos
Diagrama de Rede

Passo 2: Adicao de AP ao servidor PnP:

Integracéo de AP com atribuicdo de site Caso de uso (Implantacéo de rede

baseada em intencdo)

Integracéo de AP sem caso de uso de atribuicdo de local (implantacdes de rede
sem intencdo. como Garantia, Configuracéo por dispositivo)

Criacao de modelo de 1 dia zero no Catalyst Center

Reivindicacéo de 2 AP sem atribuicdo de local
Verificagéo

Solucao de problemas de integracdo de AP

Verificacbes prévias
Melhores praticas

Areas de foco de falha comuns

Validacdo de resultado recomendada

Introducao

Este documento descreve o Cisco PnP para integracédo de APs sem toque com o Catalyst Center.

Descricao

Os servigos Plug and Play (PnP) no Catalyst Center fornecem um processo de implantagao
automatizado e automatizado que simplifica o provisionamento de Ponto de Acesso (AP) e a
configuracao do local. Este guia descreve as etapas detalhadas para a integracdo de novos
pontos de acesso em varios cenarios de implantagao reais, incluindo abordagens baseadas em
intencao e ndo baseadas em intengdo. Além disso, ele oferece orientacdo abrangente para a
solugéo de problemas a fim de garantir uma experiéncia de implantagao tranquila e eficiente.



Requisitos

Conhecimento destes tépicos:

Controladores sem fio Cisco Catalyst 9800 Series

* Pontos de acesso Cisco

» Automagao e provisionamento sem fio do Catalyst Center

Implantacdes do Catalyst Center Assurance

» Configuragao por dispositivo (PDC)/automagéo de campus do Catalyst Center

Pré-requisitos
» Cisco Catalyst Center com 2.3.7.9 ou posterior.

» Controlador sem fio Cisco Catalyst 9800 Series
* Opcao 43 configurada na configuracéao do servidor DHCP do AP com o endereco IP da
interface empresarial do Catalyst Center. Consulte o exemplo na Etapa 1.

Etapa 1 : Opcgéao 43 configurada na configuragao do servidor DHCP do AP com o endereco IP da
interface empresarial do Catalyst Center

O IP corporativo do centro Catalyst deve ser o IP da opgao 43, ja que estamos usando a
integracao do centro Catalyst. Aqui estdo dois exemplos:

+ Exemplo de IPv4 para o endereco IP corporativo do Catalyst Center: 9.7.144.14

ip dhcp pool VLAN137
network 9.7.137.0 255.255.255.0
default-router 9.7.137.1
option 43 ascii 5AIN;B2;K4;19.7.144.14;380



» Exemplo de IPv6 para o endereco IP corporativo do Catalyst Center: 2001:60:60:60::133

ipv6e dhcp pool AP_PNP
address prefix 2001:70:70:70::/64
Tink-address 2001:70:70:70::7/64
vendor-specific 9
suboption 16 ascii "ciscopnp"
suboption 17 ascii "5A1D;B3;K4;I2001:60:60:60::133;380"

+ Exemplo de DNS para o enderego IP corporativo do Catalyst Center

ip dhcp pool v1an200
network 10.200.0.0 255.255.0.0
default-router 10.200.0.1
domain-name pnpagent.test.com
dns-server 8.8.8.8

* Os APs devem estar no modo out of box ou no modo de redefinicao de fabrica para que o
agente PnP inicie no AP.

» A conectividade de rede deve existir entre APs, Catalyst Center e controlador sem fio.
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Passo 2: Adicao de AP ao servidor PnP:

O usuario pode ir paraPagina Plug and Play no menu principal > Provisionar > Dispositivos de
rede > Plug and Play.

Ha duas maneiras de adicionar novos dispositivos a pagina PnP para integragéo

2.1 APs pré-adicionados do usuario: Adicao de dispositivo Unico ou carregamento CSV em
massa. Os usuarios podem pré-adicionar dispositivos usando o numero de série, o PID e o nome
do AP para pré-reivindicar o AP. Quando o AP se conecta e entra em contato com o servidor
PnP, a configuragdo automatica do PnP € enviada para o AP do Catalyst Center.

Adicao de um unico dispositivo:
Adicionar dispositivos->Adicionar um unico dispositivo:
Add a Single Device "

Serial Numibar®

12345

Freduct ID*

Davice Mame
i

Tasq

Numero de série e requisitos de PID ao adicionar dispositivo

Adigao de dispositivos em massa por CSV:

Add Devices in Bulk *

Choose a file or drag and drop to upload

m & Deswnlond Fils Tormplate



2.2 Os APs se conectam através da rede: APs que nao sao pré-adicionados ao PnP. Depois que
o AP é conectado a um switch e ligado com as configuragcdes padrao de fabrica, o AP entra em
contato com o servidor PnP no Catalyst Center, aparece na pagina Provision -> Plug and Play e
esta pronto para reivindicar.

Ha dois casos de uso de implantagao para integrar um novo AP com base na implantagao de
rede que vocé configurou no Catalyst Center .

1. Implantagao de rede baseada em intencao - Va para AP onboarding com atribui¢cao de site
Caso de uso (Implantagao de rede baseada em inteng¢ao).

2. Implantagéo de rede nao baseada em intengao - Va para AP onboarding sem caso de uso
de atribuicado de site (implantagdes de rede ndo baseadas em intengdo, como Assurance,
Per-Device Configuration).

Integragao de AP com atribuigao de site Caso de uso
(Implantacao de rede baseada em intencao)

Este caso de uso € adequado para clientes cuja rede sem fio foi projetada e configurada a partir
do Catalyst Center usando automacao baseada em intengéo e 9800-WLC provisionado com
locais gerenciados.

Note: Se vocé quiser configurar o local do AP como o local do site, ative a caixa de
selecao AP PnP location em System > Settings > PnP AP Location -Redirection details
mostrados na pagina.

1: A pagina PnP esta disponivel em Provisionar->Plug and Play:Selecione AP unico/varios APs
para solicitacao



and Play
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Pagina Visao Geral de PnP (Reivindicagao/Edicao/Redefinicao/Exclusdo/Autorizacéo)

2 Atribua o AP ao andar onde deseja reivindicar o AP

Assign Site to APC414.A2FB.0CBO

: Select a site - floor or cutdoor area managed by Wireless
Assign Site

Design » Controller(s).
1] Policy » Assign Site

Provision » & Two (2) Warning Algrts and On (1) Information Alert on this page. Expand to see details
5 Assurance »

Devices (1)

sts Workilows

% Emergy Management

A Tools » Devics Mame Serial Number Product I Site (Recommended) edisil
Ll - A PErPRp——— WNT 28200066 cwenTel Assign
& Activities »
Reports
3 system »
o Explote

Atribuir a um site

3 Atribuir o perfil de RF para o AP



“Hu  Catalyst Center

Configuration for device name: APC414.A2FB.0CBO

(@) assignsie @
Design » Conliguration Serial Number WNT28200060

; . ) Product 1D
) Policy > Assign Configuration

Assigned Site 31+ Joa/BOLYFLAY

. Provision » AP Loc will be configured as the assigned site a3 part of the provision during the ciaim process. Toc  Device Hame  APC14 AZFB.OCBO

vpdated, chck Refresh &
A
: RADIC FRI NCY PROFI
- Workflows Davices (1) DIO FREGQUENC OFILE

Energy Managemont

Q|
X Tools »
Device Name Sorial Numbser Product 1D Assigned Site
5 Platform »
b APCA14AZFB.OCED WHTIEZ000E6G CwaiTEl Global/San- Josell
1 J Y S .
Repodt
System »
Explo

Atribuir perfil de RF

4 se o usuario n&do habilitou o indicador de local PnP AP na configuragao do sistema e deseja
configurar o local do AP como o local do site, habilite a caixa de sele¢ao de local PnP AP em
Sistema -> Configuragdes -> Local PnP AP - Detalhes de redirecionamento mostrados na pagina
[one time enable]

Apés a configuragao, volte para a mesma pagina de atribuicdo de RF e atualize. Se estiver
habilitado, ele sera exibido em verde; se nao estiver habilitado, sera exibido em laranja.

et Catalyst Center System | Settings

Design . Certificates ki PnP AP Location
t Policy > System Certificates By selecting the below checkbox, Access Point's assigr as
AP Lo is applicable only d
Trusted Certificates
*  Provision 3

Settings Device Settings

Certificate Authority

Assurance > . . Configure AP Location
2 uranee Device Certificates

s++ Workflows Cisco Accounts ~
PnP Connect

& Energy Management
Cisco.com Credentials

A Tools »

Smart Account

= Platform 3 Smart Licensing
55M Connection Mode
2 Activities »
Device Settings W
[*] Reports
d gl Image Distribution Servers
&1 system > PnP Device Authorization

Local do AP PnP



Localizagao do AP habilitada: O local do AP é configurado como o local atribuido como parte do
provisionamento durante o processo de solicitacio.

Network Devices [ Plug and Play

g Assign Site
Design s -~

Assign Configuration

Pabicy »
2 Provision t] ° AP Location will be configured as the assigned site as part of the provision during the claim process. To change this setting, go to System -> Seltings -> PnP AP Location & . After the setling is
updated, click Refrosh =
o Assurance »

$s Workflows Davices (1) Clear Configuration ~
@y Energy Management
A Tools »

Davica Nama Sarial Numbar Product ID Assigned Site Configuration Actions
& Platform
T APCA14 AZFBOCED WNT2820006G CWa178 GlobalfSan-Jose/BGLIFLRY RF Profile: HIGH
] Activities ¥
Reports

Localizagao do AP habilitada

5 Ir para a préxima pagina Provisionar modelo sem agao necessaria e ir para a proxima pagina
verificar a visualizagao da configuragao e reivindicagéo

el Catalyst Center Netw: 25 [ Plug and Play
Configuration summary %
- PTE— oy Assign
Day-0 Configuration Preview
i) Peliey y Summary
primaryWicip 2.7144.62
_._ Provision
Devices (1) primaryWichame WLC-176-JAGY
5 Assurance > policyTaghame PT_San-J BGLIFLR1GSIS
RF TagName HMIGH
Workilow
sitoTagNamo ST_San-J_BOL_474¢c 0
Dewice Nams Sorial Humbar Produet 1D Assigned £
En
)
¥ ACIMAPRECR Wi 00080 NoT e
A Tocis ; PCA1SAZFB.OCED WNTZ8200080 CWEITH! Global/San .
= Platform > Daviea Hama
Serial Numbes
-~
Product iD
Ruparts Davice Type AP
Site GlobaliSan -Jose/BGLIFLRY
Syt
Exp
Radio Frequancy P
Radio Frequency HIGH
Profile

Resumo da configuragéo do AP

6 Depois que o AP é reivindicado, a configuragao € enviada para o AP e ele se une a um
controlador especifico que gerencia o site e aparece no inventario do Catalyst Center com
atualizagdo snmp-trap e é provisionado automaticamente com marcas de AP e localizagao do AP

Logs do console do AP:



[*09/15/2025 07:14:36.5440] PNP CONFIG - PRI WLC IP : 9.7.144.62

[*09/15/2025 07:14:36.5440] PNP CONFIG - PRI WLC NAME: eWLC-176-JAGU
[*09/15/2025 07:14:36.5440] PNP CONFIG - Policy Tag : PT_San-J_BGL1_FLR1_65f15
[*09/15/2025 07:14:36.5442] PNP CONFIG - Site Tag :ST_San-J_BGL1_474cc_0
[*09/15/2025 07:14:36.5442] PNP CONFIG - RF Tag : HIGH

show ap tag summary
APC414.A2FB.0CBO c414.a2fb.0ch0 ST_SanJ]_BGL1_474cc_0 PT_San-J_BGL1_FLR1_65f15

7 Depois que o AP ¢ adicionado ao inventario com SNMP-Trap, o AP € marcado como
provisionado e a pagina PnP e o provisionamento automatico do AP sao concluidos

Il catalyst Center Provision | Network Devices | Plug and Play

aliailis
cisea

Metwork Plug and Play Overview

Des
Palicy

*  Provision » “ i U d O Error | © P d

@ ' Devices (7) ' [ el Auto-rofrash+ 308 + Add Devices @

Waorkflows

% Energy Management

0 Selected  Actions ~ As of: S0p 15, 2025 1249 PM  Z Refresh
o Tools
Device Mame Sarial Number Product I0 Last Contast State Onboarding Prograss 1P Address MAC Address
L Platform
1 Al APBCEB 8IS FAED FVHIDOZAC IO CWaITdl Sep 11, 2025 5:00:01 PM 5.7.137.28 BC BRI 52 F4
<
& WLE-PHP FCL2B520138 COBBO-L-C-KD Sep 00, 2025 1:49:47 PM L $.7.148.76 NA
a Reports
¥ APCCOCIEFLOCED  KWC280501YE CWEIEL-8 Sep 15, 2025 12:48:15 PM v t 54187210 CC:SC:3E:F1:00
B System
¥ APFECE.S000.7778 FIC282014P3 CO1361-ROW Sep 15, 2025 12:48:13 PM v t 5.4.187.4 FR:0H:50:09:37
Exp
& ¥ APICEISETIFSTC FNT2015L3TM CONSAXE-D Sep 15, 2025 12:48:46 PM v t 9.4.187.3 26:E3:8E:71:F8
& ¥ APBCBB.BIFA.B2AD FICZN TN CWEIBIE-ROW  Sep 15, 2025 12:49:08 PM v dy 1o 9.4.157.7 BC:88181:F4:82
¥ APCAVAAZFB.OCBO  WNT2820006G CWENTEI Sep 15, 2025 12:47:35 PM v 9.4.157.28 C4:14:A2:F8:8C

Status de integragéo do AP

8 Depois que o AP ¢é adicionado ao inventario, o provisionamento automatizado aciona e
provisiona as marcas do AP e move o AP para o estado de provisionamento



ulle Catalyst Center Provision / Inventory

= g San-Jose o Roters  Switches  WirskssControlers  AccessPolts  Semsons ol = | Be _'
Design » i Eotus - T 4, Expor 5
9 BEVICE WORK ITEMS Devices [3) oows Provision Take a tour & Export C
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] Failed Provision
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*= Workflows Nan Compliant 1718216 f Success
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Exibir detalhes do AP

O local é definido no AP com base na atribuigdo do site. Execute show ap summary na CLI da
WLC:

show ap summary
APC414.A2FB.0CBO 4 Cw91781 c414.a2fb.0cb0 ecf4.0c9d.1260 US -B

Integracao de AP sem atribuicao de sitecaso de uso(nao
baseado em inteng¢ao implantacées de rede como Garantia,
Configuracao por dispositivo)

Criacdo de modelo de 1 dia zero no Catalyst Center

1.1 Va para Catalyst Center Tools > Template Hub.



el Catalyst Center

Template Hub ’ i ¢ ~ .
grated platform, we are changing the name of Cisco DNA Center to C
NA Center.

Critical Issues

View Details

Hub modelo

1.2 : Na secao de modelo, Novo projeto > Configuragao integrada > Adicionar > Selecionar novo
modelo e criar conforme mostrado, em seguida, continue.

Templates (3)

= Filtered B ¥
= d Add New Template
- Drboarting Condigurati_
44 Design ]
/| g Template Details
71 Policy
S hoscy ? Summary . .
Zlmport Template Nama*
*  provision 3 + Project Name (3 § AP-PnP-Dayl-Templat
Name * Project Type Version % S
o
g Assurance ¥ Project Name®
Sample 4 AR-PnP-Claim Onboarding Cox Regular 1
s Workilows [7] Sampie
] 1 APPnP Onboarding Configuration Regulsr 1 Template Type
P 3 Tuie (1
), Energy Management + Type @ eaular Tamalate ,
% Tamoly " 3 J KK nboarding ration r Wot Committed
X Tools ] e e o - Onbsarding Rt . Deployment Type
» Category (2 ) Day N @ Diay 0
& PMatform ] N Template Language
» Device Family (2 P 9 ]
® mua ) vewociTy
2 Activities y » Device Series (1 Software Type*®
Reports » Commit State (2
* Provigion Status (1
1 System ] Device Type Details
al Design C b ol ik
& Exploré

Device Details®  Edit Davice Detslts

Device Family Wireless Controlier

Devices Catalyst Q800 S

* Additional Details

Novo modelo



Novas entradas de modelo.

* Insira estes detalhes:

* Nome do modelo:** Insira um nome para o modelo

* Nome do projeto:** configuragéo integrada

» Tipo de Implantag&o:** Dia0

 Idioma do modelo:** Jinja

» Tipo de software:** Cisco I0S XE

* Familia de dispositivos:Controlador sem fio **

* Modelo do dispositivo:** Cisco Catalyst 9800 Wireless Controller

Exemplo do modelo de dia0 do AP:

"WIcIP primario": "9.7.149.10"

"secondaryWiIclIP": "9.7.14.62",

"policyTagName": "tag-politica-padrao”,

"NomeMarcaSite": "tag-site-padrao”,

"RFTagName": "default-rf-tag",

"PrimaryWIcName": "JAGU-EWLCAPWORKFLOW",

"secondaryWIcName": "eWLC-176-JAGU"

1.3 Adicione detalhes de configuragdo no modelo para enviar para o AP durante a reivindicagao
do AP por meio do salvamento e confirmacao do modelo.



I;IIIEI:!DII Catalyst Center Design [ CLI Templates

CU Templates > J AP-PP-Day0-Template (Not Commilted) Templste Properties

Templates Variables Simulation Provision Conflicts

44 Design ¥
) System Variables Assistant = Template History () Show Design Conficts

Policy H

*  Provision »

g Assurance H

+= Workflows

Energy Management

*\ Tools ¥
Platform ¥

®  Activities »
Reparts

] System ¥

@' Explore

- .
Discard Changes Save m

Secgao Design do Modelo

Reivindicacao de 2 AP sem atribuicdo de local

2.1 Acesse a pagina Provisionamento > Plug and Play e selecione o AP e a reivindicagéo

S

Note: Vocé pode selecionar APs unicos/multiplos e atribuir um modelo.



Catalyst Cen

Design
1] Peliey
_"_ Provision

Assurance
wee Workllows
4 Energy Management
Y Tools

L Platform
T Activities

Reports

sl System

g Explore

Network Plug and Play Overview

Device States |y (3) Unclaimed (2)
Devices (3) Focus | AN~

15elected  Actions ~

© Eror(0) @ Provisioned (1)

Auto-refrash- 305 ~ + Add Devices @

Asof: Sep13, 2025 5:20PM O Redresh

B - Chim  yame Serial Numbir Product ID Last Contact State Onboarding Pragress 1P Address MAC Address
Edit
1 1 188152 FAED FVH202AC30 cwardl Sep 1, 2025 50001 PM g Device Iy to d 9.7.137.2n BC:BB:81:52:F4
2 4 Delete  |yp FCL26520138 COBOO-L-C-K§  Sep 09, 2025 1:40.47PM ¢ O proy j 9.7.148.76 HA
3 A AZFB.OCBO  WNT28200066 w178l Sep 13, 2025 5:20-04 PM inclaimed Device is ready to be claimed.  §.4.157.28 4214242 :FB:6C

Reivindicacdo AP sem atribuicao de local

2.2 Na proxima pagina, nao selecione nenhum site na pagina de selegao e va para a proxima
pagina.

Design
1 Policy

2 Provision
& Assurance

= Workflows
Energy Managemaent
A Teols
Platform
& activities
Reports
zl  System

Devices (1)

Device Name

APCATA AZFE.OCH0

Cancel

i Albts and Ona (1) Information Alert on this page. Expand 1o See Selsily

Serial Humber Produst 18 Site (Recommended) Actions

WNT2EZ00060 CwaTe Assign

Showing 10f 1

Atribuicao de local (deixar desmarcado)

2.3 Na pagina de selegdo de modelos, selecione o modelo que sera criado.



Ass
@ Assign Site =an
Configuration

Design »
7 Pelicy 3 Assign Configuration
2 Provision » AP Location will be eonfigured as the assigned site as past of the provision during the claim process. To change this selting, go 10 System => Settings > PP AP Location . Aft
©  updated, ciick Refroeh =
o Assurance »
- Warkflows Devices (1)
1@, Enorgy Management
A Tools » .
Device Name Sorial Mumber Product ID Assigned Site Configuration
L Platferm »
*  APC414.AZFB.OCED WHT 28200060 CWINTEL HA Template: Assign”
2  Activities »
Reports
2l System s
& Explore
Showing 1 of 1

(1) Selecionar modelo

or the setting is

Clear Configuration ~

Actions

2.4 Clique no modelo atribuir e, na lista suspensa, selecione o modelo criado para enviar por push

para AP e salvar

Assign
@- Assign Site seign
Design » Configuration

1] Policy » Assign Configuration

2 Provision » ® AP Location will be configured as the assigned site as pari of the provision during the claim process. Te
updated, chek Refresh =

o Assurance ¥

+i2 Workflows Devices (1)

{74 Energy Management

Tools »
K Ted Davice Mame Serial Humbar Produst 1D Assigned !
L Platform »
*  APCA14.AZFBOCED WNTZBZ00066  CWII7I m
T Activities »
2 Reparts
S System »
o) Explors
Shawing 1611

(2) Selecionar modelo

Configuration for device name: APC414.A2FB.0CBO

Serial Humber  WNTZ28200065
Produet ID cwarel
Assigned Site Mo Site

Device Name APCAN4AZFB.OCED

A Failed 10 retrieve a device-specific template. Select from

templates:

AP-PnP-Day0-Te

2.5 Cliqgue em Next (Avancar) e visualize a configuracao para AP e solicitar

the avsilsbie onboarding



Design

Polley

Pravision

o Assurance

= Workflows

@ Energy Management
A Tools
n  Platform
T Activities
Reports
System
o Explore

Assign
— o
() Assign site Configurtion
Assign Configuration

AP Location will be configured as the assigned site as part of the pravision during the claim process. Tx
updated, click Refresh <

-]

Devices (1)

Davice Mama Sarial Humbar Produst 1D Ansigned ¥
kL APCA14.AZFB.OCED WNT28Z0006G Cwol7a MA
Showing 1 of 1

(3) Selecionar visualizagao da configuragédo de modelo

Configuration for device name: APC414.A2FB.0CBO "

Daovies Mame  APCA14.A2FB.OCED

Failed ta retrieve a device-specific template. Select from the available onboarding
tempdates.

Select a Template

Copy r an to startup configurs
Template  AP-PnP-Day0-Template

Project Onboarding Configuration

Created Sep 13, 2025 5:05:38 PM

Updated Sep 13, 2025 &

PM

Export Copy

{
primaryNlcIP™: “9.7.149.18°,
“secondryWlcIP™: °9.7.144.62",
policyTaghame™: “default-policy-tag”,
“siteTagheme™: “defoult-site-tag”,
RFTagMame” : “default-rf-tag® ,
primaryWlcMase™; °JAGU-EWLCAPWORKFLOW®,
“secondryWlchase™: “eWLC-176- JAGU"
]

concer ()

2.6 Apds a reivindicagao, a configuragao é enviada para o AP e o AP se junta ao respectivo
controlador. Ele é exibido no inventario

Design
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Depois de entrar no controlador sem fio, o AP é exibido no inventario com base neste caso de

uso:



» Caso de uso1 - Implantacao de garantia # Novo AP reivindicado para o controlador sem fio
que € adicionado no Catalyst Center com atribuicdo somente de local, novo AP integrado
aparece no inventario com sincronizaciao snmp-trap. Depois que o AP aparecer, o inventario
estara pronto para ser gerenciado a partir do Catalyst Center.

» Caso de uso2 por dispositivo # Novo AP reivindicado para o controlador sem fio que é
adicionado no Catalyst Center sem atribuicao de local, o novo AP integrado ndo é mostrado
no inventario até a sincronizagao 1. Depois que o AP aparece no inventario, ele esta pronto
para ser gerenciado a partir do Catalyst Center.

Verifique no controlador wireless:

show ap tag summary
show ap summary

 Verifique a pagina PnP depois de adicionar AP ao inventario, que deve ser marcada como
Provisionado.
- Para isso, navegue até Provisionar > Dispositivos de Rede > Plug and Play na GUI do
Catalyst Center.

Solucao de problemas de integracao de AP

Verificacdes prévias

» Certifique-se de que a Opg¢ao de DHCP 43 ou DNS esteja configurada corretamente para
que o AP possa descobrir o servidor PnP.

» Verifique se o AP tem alcance para o Catalyst Center usando ping, traceroute e verificagdes
basicas de conectividade de rede.

 Verifique se o AP aparece na pagina PnP sem erros.

» Validacao de Declaragao PnP

* Quando o AP estiver visivel na pagina PnP, verifique os detalhes do dispositivo antes da
solicitacao.

* Quando o usuario solicitar o AP, verifique os detalhes da visualizagao.

» Verifique o status da reivindicagao depois que ela for enviada.

* Quando a reivindicagado do AP estiver concluida, verifique se o AP progride corretamente no
fluxo de trabalho de integragao.

+ Validagao do controlador sem fio

* No controlador sem fio, verifique o status de ingresso do AP usando:show ap summary



show wireless stats ap join summary

« Se 0 AP nao ingressar na controladora, identifique o motivo da falha de ingresso e tente a
integragdo novamente apos executar uma redefinigao de fabrica do AP, se necessario.

* Se o0 AP for reivindicado e unido ao eWLC e o status do fluxo de trabalho PnP executado for
visto, mas o AP ainda nao estiver visivel no Inventario do Catalyst Center, verifique o
servico de inventario, o processamento de interceptacao e a sincronizagao de inventario.

Melhores praticas

Evite executar atividades de provisionamento na WLC envolvida na integracdo de novos APs.

As atividades de provisionamento simultaneas podem acionar a sincronizacao de inventario, o
qgue pode resultar em atraso na fila ou no registro posterior.

Evite disparar manualmente solicitacées de ressincronizagao iniciadas pelo usuario na WLC, a
menos que seja necessario para a solugao de problemas.

Areas de foco de falha comuns

AP nao visivel em PnP: verificar o caminho de descoberta do AP, incluindo DHCP Opcéao 43 ou
DNS.

Falha na reivindicacdo do AP: verifique os registros do servigo de onboarding.

AP reivindicado, mas nao associado a WLC: verifique o status de unido do controlador e o motivo
da falha de associacao.

Fluxo de trabalho PnP preso ap6s declaragao: se o AP tiver ingressado na WLC, mas néo estiver
visivel no Inventario, verifique o servigo de inventario, o processamento de interceptacao e a fila
de sincronizagao.

Provisao acionada, mas configuragdo nao aplicada conforme esperado: verifique provisioning-
service e network-programmer.

Validagao de resultado recomendada



Confirme se o AP foi reivindicado com éxito no PnP.

Confirme na pagina PnP do Catalyst Center se o AP ndo esta mais em estado de erro e se o
status da reivindicagao foi bem-sucedido.

Confirme se o status do fluxo de trabalho PnP executado é visivel para o AP.

Confirme se o AP se uniu a WLC.

show ap summary

show ap tag summary

show wireless stats ap join summary
show wlan summary

show wireless stats ap join summary

Verifique se o AP esta presente na lista de APs unidos e se ndo ha falhas de uniao.

Confirme se o AP esta visivel no Catalyst Center Inventory.

Valide a partir do Inventario do Catalyst Center se o AP aparece sob o local esperado e esta em
estado alcancavel.

Confirme se o fluxo de trabalho de integragéo ou provisionamento é concluido com éxito sem
erros.

No Catalyst Center, verifique se a tarefa de integragédo ou provisionamento foi concluida com
éxito.



Sobre esta tradugao

A Cisco traduziu este documento com a ajuda de tecnologias de tradugéo automatica e
humana para oferecer conteudo de suporte aos seus usuarios no seu proprio idioma,
independentemente da localizagao.

Observe que mesmo a melhor tradugao automatica nao sera tao precisa quanto as realizadas
por um tradutor profissional.

A Cisco Systems, Inc. ndo se responsabiliza pela precisdo destas tradugdes e recomenda
que o documento original em inglés (link fornecido) seja sempre consultado.



